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@ 1. Configuring the development board - ESP-LAUNCHER

1. Configuring the development
board - ESP-LAUNCHER

1.1. Hardware Preparation

To get started with developing applications for the ESP8266, you will need the hardware
and the corresponding software tools. There are listed as follows:

¢ One of the following ESP8266 Hardware Development Kits (HDK):
- ESP8266 official development board, ESP-LAUNCHER, as noted in Table 1-1.
- ESP8266 official module, ESP-WROOM-02, as noted in Chapter 6.

e PC for programming: Windows XP or Windows 7 OS is recommended, with enough
RAM to run a Linux virtual machine.

e Micro USB cable.

—| Notes:

« If you are using third party development boards or modules that integrate ESP8266, please use the
development firmware provided by the corresponding manufacturers.
» If you would like to purchase ESP-WROOM-02 or ESP-LAUNCHER, please visit Espressif's official

online store at: https.//espressif.taobao.com,.

Table 1-1. The ESP8266 Development Board

ESP-LAUNCHER

e 1 ESP-LAUNCHER
e 1 Micro USB cable

! Notice:

The ESP8266 Wi-Fi module requires 3.3V power supply and may draw current in the order of 500 mA.
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@ 1. Configuring the development board - ESP-LAUNCHER

1.2. Software Preparation
e ESP8266 official Flash Download Tool

- Download: http.//www.espressif.com/support/download/other-tools
o ESP8266 official SDK

- Download SDK: http.//www.espressif.com/support/download/sdks-demos

- The official AT firmware (ESP8266_NONOS_SDK\bin\at) can be downloaded into the
ESP-LAUNCHER by referring to the BIN locations mentioned in the "ReadMe" file
which is in the same directory. For instructions on downloading the firmware into the
ESP-LAUNCHER, please refer to Section 1.3.

e PC UART terminal emulator tool
- SecureCRT/ minicom is recommended.

- UART tools mentioned above can support the default baud rate (74880) of ESP8266.
Note that certain USB-UART converters may not support all baud rates if you are
using a third party development board.

1.3. Download Firmware into The ESP-LAUNCHER

1. Using the ESP8266_NONQOS_SDK_V2.0.0_16_07_19 as example. The AT firmware
binaries are located in
ESP8266_NONOS_SDK _V2.0.0_16_07_19\ESP8266_NONOS_SDK\bin

> [ at
» [ at_sdio
b blank.bin
b boot_v1.2.bin
' boot_v1.6.bin
b esp_init_data_default.bin

Figure 1-1. ESP8266_NONOS_SDK bin Folder
2. Settings of the development board, ESP-LAUNCHER.
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Figure 1-2. The ESP-LAUNCHER
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1. Configuring the development board - ESP-LAUNCHER

Z

e The switch 1: toggle to the lower side;

e The switch 2: toggle to the lower side;

* The switch 3: toggle to the upper side;

e The pin 4: put a jumper cap on the above 2 pins;
e The pin 5: put a jumper cap on it.

3. Use micro USB cable to connect the ESP-LAUNCHER to the PC. The UART driver
needs to be installed on the PC.

4. Double-click ESPFlashDownloadTool v3.3.4.exe to run the ESP8266 Flash Download

Tool on PC.
B3 ESP8266 DOWNLOAD TOOL V3.3.4 - 0O X
SPIDownload | HSPIDownload | RFConfig = MultiDownload
~Download Path Config
© | _07_19\€SP8266 NONOS_SDK\bin\blank.bin
 [6.NONOS SOR\biesp it date defliin
© [_07_19\ESP8266_NONOS_SDK\bin\blank.bin .
© [_07_19\E5P8266 NONOS_SDK\bi\blank.bin ..
© [ 1598266 NONGS SDbimboot 1650 -
 [sDK\bin\at\1024+1024\user1.2048.new.5.bin
DeviceMasterKey Folder Path
| |
— SpiFlashConfig ]
. .. |~FLASH SIZE - -
CrystalFreq : CombineBin [~ SpiAutoSet
Ist vI Default " 4Mbit I~ DoNotChgBin
~SPI SPEED - SPI MODE | ¢ 2Mbit li' LOCK SETTINGSJI
& 40MHz & QIO € 8Mbit —DETECTED INFO —
¢ 267MHz || C QOUT € 16Mbit
 20MHz « DIO © 32Mbit
 80MHz « DOUT @ 16Mbit-C1
" 32Mbit-C1
Download Panel 1
START | stop | COM: |comg =
BAUD: |1152000 |

Figure 1-3. ESP8266 Flash Download Tool
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1. Configuring the development board - ESP-LAUNCHER

Figure 1-3 uses 16 Mbit-C1 (1024+1024 map) flash as an example. The locations of
binaries to be downloaded into are as Table 1-2 shows.

Table 1-2. Download AT Binaries for 16 Mbit-C1 Flash Map

blank.bin 0x1FB0O00 Initialize RF_CAL parameter area.

Stores default RF parameter values, has to be downloaded into
flash at least once.

If the RF_CAL parameter area is initialized, this bin has to be
downloaded too.

esp_init_data_default.bin  0x1FC000

blank.bin OxFEOOO Initialize Flash user parameter area.
blank.bin Ox1FEOOO Initialize Flash system parameter area.
boot.bin 0x00000 In \bin\at.

user1.2048.new.5.bin 0x01000 In \bin\at\1024+1024.

Notes:

* The SpiFlashConfig area and the COM area on the ESP8266 Flash Download Tool should be set
according to the actual hardware configuration of the ESP8266 development board.

e For more information of downloading AT firmware, please refer to documentation ESP8266 AT
Instruction Set.

5. Click the START button to enter the SYNC state, waiting for the ESP-LAUNCHER to
power up.

~Download Panel 1
SYNC

COM: |c0M9

BAUD: |1152000

Figure 1-4. SYNC State of the ESP8266 Flash Download Tool

4/23 2016.11
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6. Power on the ESP-LAUNCHER by toggling the switch 1 to the upper side.

USB-serial Cable
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The ESP8266 Flash Download Tool will start to download AT firmware into the ESP-

Figure 1-5. The ESP-LAUNCHER

LAUNCHER. The DETECTED INFO area will display information about the flash chip on

the ESP-LAUNCHER.

~SpiFlashConfig
CrystalFreq : CombineBin || e
|26M ;l Default " 4AMbit
~SPISPEED | SPI MODE | ¢ 2Mbit
& 40MHz & QIO € 8Mbit
¢ 267MHz || © QOUT € 16Mbit
 20MHz ¢ DIO € 32Mbit
. PR @ 16Mbit-C1
¢ 32Mbit-C1

I~ SpiAutoSet
I~ DoNotChgBin

I~ LOCK SETTINGS

—DETECTED INFO

flash vendor: -
Alh:FM

flash devID:

4016h

QUAD:32Mbit

crystal:

2 Mhz -

~Download Panel

1

Download

R

AP MAC: S5E-CF-7F-14-C7-45
STA MAC: 5C-CF-7F-14-C7-45

COM: |c0M9

BAUD: |1152000

Figure 1-6. ESP8266 Flash Download Tool - Downloading Firmware

After the download is finished, toggle the switch 1 to the lower side to power off the ESP-

LAUNCHER.

Espressif
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1. Configuring the development board - ESP-LAUNCHER

<

~Download Panel 1

=0 |AP MAC: SE-CF-7F-14-C7-45
ook STA MAC: 5C-CF-7F-14-C7-45
e

START | stop |COM: [cOMg

BAUD: |1152000
EEEREEREEREREEREEEE NN NN

Figure 1-7. ESP8266 Flash Download Tool - Finishing downloading Firmware
7. Open the UART tool on PC, set baud rate to 115200, check the New line mode for the

UART tool.
Category:
=) Connection Serial Options
i i-Logon Actions —
L Port: comg v  Flow control
) — r—
- Berwsinet Baud rate: 115200] v s
(=)~ Emulation RTS/CTS
M| owats S
Wi party:
-~ Mapped Keys LAk
[=)- Appearance
Category:
f=J- Connection Emulation Modes
L Log.on Actions Initial modes Current modes
i -Serial
&3 Terminal Cursor key mode Cursor key mode
&) Emulation Line wrap Line wrap
 Emacs New line mode New line mode
~~Mapped Keys @ Numeric keypad @ Numeric keypad
- Advanced o .
& Appearance () Application keypad () Application keypad

Figure 1-8. UART Emulator Tool on PC
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@ 1. Configuring the development board - ESP-LAUNCHER

8. Set the ESP8266 to operation mode by toggling the switch 2 to the upper side. Then
toggle the switch 1 to the upper side to power on the ESP-LAUNCHER.

upper side 2 8 ——
0) ® ®
sl ¢
USB-UART ==s==snns ' EI Le] [=] ® e
A o °
H ® — @
—(_Jatr O
0
— PLE
H A @ ®
oy B2 T
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n
)
@) ON=1C
lower side 5 a

Figure 1-9. The ESP-LAUNCHER

At first, the PC UART tool will output some garbage characters (which is normal, because
the power-on-default baud rate of ESP8266 is 74880). The PC UART tool will then output
"ready" message, indicating that the ESP-LAUNCHER is running the AT firmware
successfully.

| 2bR 217 € Fr Tqr UL B 7B LG 7bIER TS bIE
T€ 1 +blE217? |?2r 1qr 14

ready

AT+GMR

AT wversion:1.3.0.0(Jul 14 2016 18:54:01)
SDK version:2.0.0(B56edbf)

compile time:Jul 19 2016 18:44:22

|OK

Figure 1-10. AT Logs on The UART Tool

Input command "AT+GMR" through the UART tool, and press Enter button. You will get a
response printing version information of the AT firmware.

For more AT commands and examples of AT command usage, please refer to the
documentations ESP8266 AT Instruction Set and ESP8266 AT Command Examples.

Espressif 7/23 2016.11
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2. Compiling Applications

NP

Compiling Applications

This chapter presents the workflow of compiling a program for the ESP8266 based on the
ESP8266_NONQOS_SDK, using the AT demo application provided by Espressif Systems as
an example.

2.1. Downloading The Development Environment

1. PC: Windows XP or Windows 7 OS is recommended.

2. The development environment provided by Espressif Systems is based on Lubuntu. The
Espressif Systems also provides a virtual image of the development environment that
can be run on VirtualBox.

® Download VirtualBox-5.0.16-105871-Win.exe:

httos://www.virtualbox.orag/wiki/Downloads

_| Note:
Please choose the correct version of VirtualBox according to your host machine OS.
® Download ESP8266_lubuntu_20141021.ova at:
Baidu:
https.//pan.baidu.com/s/1dEOw8bZ
Password: v81b

Google:

https://drive.qoogle.com/folderview?

([d=0B5bwBE9ASdBXaExvdDEXVENrUXM&usp=sharing

Espressif 8/23 2016.11
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2. Compiling Applications

2.2. Setting up Development Environment

Espressif

Steps

1. Start Windows OS and install the virtual machine.

e Double-click
VirtualBox-5.0.16-105871-Win.exe
and install VirtualBox.

] Note:

VirtualBox has different versions. We are
using Windows V.5.0.16 as an
example.

e Double-click Oracle VM
VirtualBox.exe to run the program
and the system will display the main

menu
" Tip:
ESP8266 virtual machine takes up a lot

of space (RAM). Please make sure your
machine has enough memory to spare.

File Machine Help

W D

New Settings Discard Start,

Results

Welcome to VirtualBox!

The left part of this window is a list of all virtual machines on your computer. The list is empty now

because you haven't created any virtual machines yet.

In order to create a new virtual machine, press the New button in the r " 4

main tool bar located at the top of the window.

You can press the F1key to get instant help, or visit
www.virtualbox.org for the latest information and news.

_@ @3 snapshots

3

P

:‘{

2. Set VirtualBox default machine folder.

e Create a new folder, for example, D:
\VM.

e Select File > Preferences, the
system shows the dialog box

¢ Inthe General tab, set the location
for the virtual machine in Default
Machine Folder, for example, D:
\VM.

5 Tip:

ESP8266 virtual machine takes up a lot
of space (RAM). Please make sure your
machine has enough memory to spare.

& Viruate

@ General
@ Input

@ Update
@ Language
Display
@ Network
D Extensions
EB Proxy

9/23

General

Default Machine Folder: l D: AWM

VRDP Authentication Library: l | VBoxhAuth

Cancel

Help

2016.11
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. Import the image file.

Select File > Import Appliance, a
dialog box will show up « .

Select the demanded image file, for
example, C:
\ESP8266_Ilubuntu_20141021.ova,
and click Next.

Click Import to confirm the settings.

. Create a shared folder.

Create a new folder named DAVM
\share.

Select Machine > Settings >
Shared Folders..., a dialog box will

show up

Select the shared folder in Machine

Folders, for example, D:\VM\share.

2. Compiling Applications

ey

@ Import Virtual Applian

P

Appliance to import

VirtualBox currently supports importing appliances saved in the Open Virtualization Format
(OVF). To continue, select the file to import below.

C:\ESP8266_Iubuntu_20141021.ova|

R

Expert Mode | |

Next ] [ Cancel

# ESPB266_lubuntu_1 - Settings (2]

@ General
m System
Display
B Storage
W Audio

@ Network
@ Serial Ports
& use

Shared Folders

Shared Folders

Folders List

Name Path

= Machine Folders
share D:\¥Mishare

Auto-mount  Access

Yes Full

o8

J[ Cancel ][

Help ]

10/23
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@ 2. Compiling Applications

5. Run the virtual machine.

@ w U . 3 Snapshots

New Settings Discard Start
ESP8266_lubuntu = General = preview il
I @ © Powered Off
Name: ESP8266_lubuntu

. . . . Operating System: Ubuntu (32-bit)
e After importing, a virtual machine @ syetem
named ESP8266_lubuntu shows up Base Memory: 1024 M3 ESP8266_lubuntu

Boot Order: Optical, Hard Disk
Acceleration:  VT-x/AMD-V, Nested
Paging, PAE/NX

1

* Double-click ESP8266_lubuntu or @ oipiay
Start to power on the virtual Video Memory: 12M8
. Remote Desktop Server: Disabled L3
maCh|ne Video Capture: Disabled
;ﬂ Storage

Controller: IDE

IDE Secondary Master: [Optical Drive] Empty
Controller: SATA

SATA Port 0: ESP8266_lubuntu-disk1.vmdk (Normal, 8.00 GB)
@ Audio

e The system shows ESP8266 virtual
machine

e [f the virtual machine enters idle
mode and is locked, a dialog box as LXTerminal
below “+ will show up, please enter
the password: espressif.

ESP8266 v

N
t j fl 3

Unlock

e Double-click LXTerminal to start

. ) . Z «) (8 & 1y 1826 (O
compiling applications, for more BOSsa= @@ B rgtor

details please refer to Chapter 2.3.

Espressif 11/23 2016.11



2. Compiling Applications

2.3. Compiling Applications Using ESP8266_NONOS_SDK

1. Start the virtual machine. Run LXTerminal on the desktop of the virtual machine.

2. Copy the ESP8266_NONOS_SDK to be compiled to the shared folder.

Steps

Result

Espressif

Copy ESP8266_NONOS_SDK folder on PC to

the shared directory, for example, D:\VM\share.

Copy ESP8266_NONQOS_SDK\examples\at
folder to the directory D:\VM\share
\ESP8266_NONOS_SDK, as shown in the

figure on the right

> VM > share > ESP8266 NONOS_SDK

N

at

bin
documents
driver_lib
examples
include

Id

lib

tools

Mount the shared directory to the virtual machine.

Steps

Execute command . /mount.sh inthe
[ XTerminal.

Input the password: espressif.
Shared folder mounting is completed.

Open the shared directory
ESP8266_NONOS_SDK in the virtual machine

and confirm if the mounting is successful.
- If successful, the directory contains files as
the figure on the right shows.

- If not, the directory will be empty and you
will need to repeat the above step again.

12/23

File Edit Tabs Help

File Edit
Fl< -

Places

4} Home Folder

B Desktop

i Trash Can
@ Applications

[® Documents

[@ Music
[@ Pictures
[@ Videos

[® Downloads

11items (1 hidden)

Result

ESP8266_NONOS_SDK - + X
View Bookmarks Go Tools Help
> A @ |/home/esp8266/Share/ESP8266_NONOS_SDK M
v : N N
bin documents  driver_lib

o

lib

—

include

License

m
2
3
°
3

i

E

tools Makefile

Free space: 192.8 GiB (Total: 394.4 GiB)

2016.11
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2. Compiling Applications

4. Change the directory to /share/ESP8266_NONOS_SDK/at in the LXTerminal and
compile it.

Steps Result
¢ |n the LXTerminal, Change the directory by B esp8266@esp8266-Vir...P8266_NONOS_SDK/at — + X
executing command: cd /home/esp8266/ File Edit Tabs Help

Share/ESP8266_NONOS_SDK/at

* Then execute command: ./gen_misc.sh
to start compiling.

e For example, the choices for STEP 1 ~ 5 in the
compilation can be: 1, 1, 2, 0 and 5
respectively.

== Note:
For more details on compiling applications, please refer to ESP8266 SDK Getting Started Guide.

5. After compilation, the binaries generated and their corresponding download addresses
on flash memory are as follows:

Support boot v1.4 and +

Generate userl.2048.new.5.bin successfully in folder bin/upgrade.
booiEMbiilnEEEEEEE s >0x00000

userl.2048.new.5.bin--->0x01000

= Note:

You can open /home/esp8266/Share/ESP8266_NONOS_SDK/bin/upgrade directory and check the
binaries compiled.

6. The AT binaries generated can be downloaded to the ESP-LAUNCHER (refer to
Section 1.3 ) and run.

13/23 2016.11
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@ 3. Learn More About ESP8266_RTOS_SDK

Learn More About
ESP8266 RTOS SDK

3.1. Compiling Application Using ESP8266_RTOS_SDK

1. Download the ESP8266_RTOS_SDK at:

https.//qgithub.com/espressif/ESP8266_RTOS SDK
ESP8266_IOT_PLATFORM is a demo application based on ESP8266_RTOS_SDK.
Download at: https.//qgithub.com/espressif/ESP8266 _I0T _PLATFORM

2. Copy ESP8266_IOT_PLATFORM and ESP8266_RTOS_SDK to the PC's shared
folder.

o

Steps Result

e Copy ESP8266_RTOS_SDK and
ESP8266_I0T_PLATFORM folder to the > VM > share
shared folder of the PC, for example, D\VM A
\share.

* As shown in the figure on the right

ESP8266_|OT PLATFORM
ESP8266 RTOS_SDK

3. Start the virtual machine. Run LXTerminal on the desktop of the virtual machine.

Steps Result

« Start ESP8266 virtual machine «-. BB EsPa256 lubuntu [Running] - Oracle VM VirtualE o

- If the virtual machine is locked, please enter
the password: espressif to unlock it.

e Double-click LXTerminal to start compilation. LXTerminal

EAl & EE T == ) (8
‘ BOF a0 @ @ikt cel

Espressif 14/23 2016.11
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Steps

Execute command . /mount.sh in the
L XTerminal.

Input the password: espressif.
Shared folder mounting is completed.

Open the shared directory
ESP8266_RTOS_SDK in the virtual machine
and confirm if the mounting is successful.

- If successful, the directory contains files as
shown in the figure on the right

- If not, the directory will be empty, you will
need to repeat the above step again.

Steps

SDK_PATH: the directory of
ESP8266_RTOS_SDK

BIN_PATH: the directory which the binaries are

generated in after compilation

As the figure on the right shows.

Steps

Revise the "LINKFLAGS_eagle.app.v6" area in

the ESP8266_IOT_PLATFORM\makefile:
- Delete -Iminic
- Add -Icirom and -Imirom

As the figure on the right shows.

15/23

3. Learn More About ESP8266_RTOS_SDK

. Mount the shared directory to the virtual machine.

Result

File Edit Tabs Help

(] ESP8266_RTOS_SDK -+ x
File Edit View Bookmarks Go Tools Help

[#l € ¥ > A |@ /home/esp8266/Share/ESP8266_RTOS_SDK Yy
Places v = e —— —

G} Home Folder dg ﬂ;l M H

B Desktop bin documents  examples extra_includ

& Trash Can e

[@ Applications

[@ Documents Lg U;l H dg’
@ Music include d lib third_party
[ Pictures

(@ Videos — ‘ = ‘ ‘ = ‘ =

@ Downloads tools LICENSE ~ Makefile ~README.md

12items Free space: 192.7 GiB (Total: 394.4 GiB)

. Set the SDK_PATH and the BIN_PATH in ESP8266_IOT_PLATFORM\gen_misc.sh.

Result

[= gen_misc. shEd

11 export SDK_PATH=~/Share/ESP8266_RTOS_SDK
12 export BIN_PATH=~/Share/ESP8266_RTOS_SDK/bin

. Revise the ESP8266_IOT_PLATFORM\makefile.

Result

LINKFLAGS_eagle.app.v6 \
-L$ (SDK_PATH) /1ib \
-Wl,--gc-sections \
-nostdlib \
-T$(LD_FILE) \
-Wl,--no-check-sections \
-u call_user_start \
-Wl,-static
-Wl,--start-group
-lcirom \
~-lmirom \

2016.11



@ 3. Learn More About ESP8266_RTOS_SDK

7. Change the directory to /share/ESP8266_IOT_PLATFORM in the LXTerminal, and
compile it.

Steps Result

e |n the LXTerminal, change the directory by B esp8266@esp8266-VirtualBox: ...hare/ESP8266_IOT_PLATFORM — + X
File Edit Tabs Help

executing command: cd /home/esp8266/
Share/ESP8266_IOT_PLATFORM

* Then execute command: ./gen_misc.sh
to start compiling.

== Note:
For more details on compilation, please refer to ESP8266 SDK Getting Started Guide.

8. After compilation, the binaries are generated and the corresponding download
addresses on the flash memory are as follows:

Support boot v1.4 and +

Generate userl.1024.new.2.bin successfully in BIN_ PATH
boot.bin------------ >0x00000
userl.1024.new.2.bin--->0x01000

-l Note:

You can open /home/esp8266/Share/ESP8266_RTOS_SDK/bin directory and check the binaries
compiled.

9. Download the binaries generated to the ESP-LAUNCHER and run.

-] Note:
The power-on-default baud rate of ESP8266 is 74880 for the ESP-LAUNCHER.
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http://www.espressif.com/sites/default/files/documentation/2a-esp8266-sdk_getting_started_guide_en.pdf

@ 3. Learn More About ESP8266_RTOS_SDK

3.2. ESP8266 RTOS SDK Architecture
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Figure 4-1. ESP8266_RTOS_SDK Architecture
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4. Debug Methods
4. Debug Methods

4.1. Debug Methods

4.1.1. Add UART Output Logs
For ESP8266_NONOS_SDK, you can add debug logs as shown:

os_printf("SDK version:%s\n", system get sdk version());

For ESP8266_RTOS_SDK, you can add debug logs as shown:

printf("SDK version:%s\n", system_get sdk _version());

4.1.2. Debug Fatal Exception

If a fatal exception occurred, UART output logs will be as shown:

Fatal exception (28):

epcl=0x4025bfa6, epc2=0x00000000, epc3=0x00000000,
excvaddr=0x0000000f, depc=0x00000000

1. Find the corresponding .s file which is generated with the running binaries in the same
directory (ESP8266_SDK\bin).

For example, if running eagle.flash.bin and eagle.iromOtext.bin, the corresponding file
is eagle.s.

2. Locate the address of epc1 (as Ox40XXXXXX) in the .s file to find the target function that
fatal exception occurred.

3. Add logs before and after the target function is called to debug the fatal exception
problem.

4.2. Sample Codes

ESP8266 Sample Codes: http.//www.espressif.com/support/explore/sample-codes.
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http://www.espressif.com/support/explore/sample-codes

@ 5. Downloading Firmware into The ESP-WROOM-02

5. Downloading Firmware into
The ESP-WROOM-02

Please follow the steps below to download firmware into ESP-WROOM-02.

1. ESP-WROOM-02 is the official ESP8266 module provided by Espressif Systems. Lead
out the pins of ESP-WROOM-02 as shown in Table 4-1.

Table 6-1. ESP-WROOM-02 Pins

Pin Pin status Figure
EN Pull up
3V3 3.3V power supply (VDD)
1015 Pull down
UART Download mode: pull down;
106 FLASH Boot mode: floating/pull up
GND GND
RXD UART Download Rx
TXD UART Download Tx, floating/pull up

2. Connect ESP-WROOM-02 to USB-to-TTL converter using Dupont lines as shown in
Figure 6-1.

ESP-WROOM-02

USB-to-TTL converter

V.
3v3

EN

RXD D

QREE
Al [

D RXD

GND GND

| 1015 | | 100 |

Figure 6-1. ESP-WROOM-02 Download Mode
3. Connect the USB-to-TTL converter to the PC.
4. Download firmware to flash with ESP8266 DOWNLOAD TOOL.
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@ 5. Downloading Firmware into The ESP-WROOM-02

—| Note:

On how to download firmware, please refer to Section 1.3.

5. After downloading, set 100 as floating or pull up and switch ESP-WROOM-02 to
working mode.

6. Power on ESP-LAUNCHER again and the chip will read and run programs from the
flash.

_| Note:

100 is an internal pull up pin. For more information on ESP-WROOM-02 hardware, please refer to ESP8266
System Description and ESP-WROOM-02 Datasheet.
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http://www.espressif.com/sites/default/files/documentation/0b-esp8266_system_description_en.pdf
http://www.espressif.com/sites/default/files/documentation/0c-esp-wroom-02_datasheet_en.pdf

Appendix |

Appendix - Learning
Resources

I.1.

Espressif

Must-Read Documents

ESP8266EX Datasheet

Description: This document introduces the specifications of ESP8266EX, including an
overview of the features, protocols, technical parameters and applications. It also
introduces pin layout and the relevant description, as well as major functional modules
and protocols applied on ESP8266EX (CPU, flash and memory, clock, radio, Wi-Fi, and
low-power management). Besides, it provides descriptions of peripheral interfaces
integrated on ESP8266EX, lists the electrical data of ESP8266EX and illustrates the
package details for ESP8266EX.

ESP8266 Hardware Resources

Description: This zip package includes manufacturing specifications of the ESP8266
board and the modules, manufacturing BOM and schematics.
ESP8266 Non-OS SDK loT_Demo Guide

Description: This document provides simple demo implementations of three types of
smart devices: Smart Light, Smart Power Plug, and Sensor Device. It also introduces
the readers to curl toolkits, functions in LAN and WAN.

ESP8266 RTOS SDK Programming Guide

Description: This document provides sample codes based on ESP8266_RTOS_SDK,
including basic examples, networking protocol examples and advanced examples.

ESP8266 AT Command Examples

Description: This document introduces some specific examples on the usage of
Espressif AT commands, including single connection as a TCP client, UDP transmission
and transparent transmission, and multiple connection as a TCP server.

ESP8266 AT Instruction Set

Description: This document provides lists of AT commands based on
ESP8266_NONOS_SDK, including user-defined AT commands, basic AT commands,
Wi-Fi AT commands and TCP/IP-related AT commands. It also introduces the
downloading of AT firmware into flash.

ESP8266 Non-OS SDK API Reference

Description: This document lists ESP8266_NONOS_SDK APIs, provides an overview of
ESP8266_NONOS_SDK and introduces the readers to system APIs, TCP/UDP APIs,

mesh APIs, application specific APIs, definitions and data structures, and APls for
peripheral interfacing.
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http://espressif.com/sites/default/files/documentation/0a-esp8266ex_datasheet_en.pdf
http://espressif.com/en/support/download/documents?keys=ESP8266+hardware+resources
http://www.espressif.com/sites/default/files/documentation/2b-esp8266_non-os_sdk_iot_demo_guide_en.pdf
http://www.espressif.com/sites/default/files/documentation/20a-esp8266_rtos_sdk_programming_guide_en.pdf
http://www.espressif.com/sites/default/files/documentation/4b-esp8266_at_command_examples_en.pdf
http://www.espressif.com/sites/default/files/documentation/4a-esp8266_at_instruction_set_en.pdf
http://www.espressif.com/sites/default/files/documentation/2c-esp8266_non_os_sdk_api_reference_en.pdf

@ Appendix |

o ESP8266 RTOS SDK API Reference

Description: This document lists ESP8266_RTOS_SDK APIs, including functions for Wi-
Fi related APIs and boot APls, etc.

* FAQ

.2. Must-Have Resources

e ESP8266 SDKs

Description: This website page provides links to the latest version of ESP8266 SDK and
the older ones.

ESP8266 Tools

Description: This website page provides links to the ESP8266 flash download tools and
ESP8266 performance evaluation tools.

ESP8266 APK

ESP8266 Certification and Test Guide

ESP8266 BBS

ESP8266 Resources
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http://espressif.com/en/support/download/documents?keys=ESP8266+RTOS+SDK+API+Reference&field_type_tid%5B%5D=14
http://espressif.com/en/support/explore/faq
http://www.espressif.com/en/support/download/sdks-demos?keys=&field_type_tid%5B%5D=14
http://www.espressif.com/en/support/download/other-tools?keys=&field_type_tid%5B%5D=14
http://www.espressif.com/en/support/download/apks?keys=
http://espressif.com/en/support/download/other-tools?keys=ESP8266+Certification+and+Test
http://bbs.espressif.com
http://www.espressif.com/en/products/hardware/esp8266ex/resources
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